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1. Wprowadzenie

AVR PROG MKII to narzędzie do programowania wszystkich 8 bitowych 
mikrokontrolerów  AVR również z uwzględnieniem najnowszej rodziny ATXMEGA. 
Programator jest kompatybilny z AVRISP mkII.  Programator obsługuje magistrale 
ISP, PDI i TPI. 
W urządzeniu zastosowano buforowanie sygnałów we/wy co zwiększyło odporność 
układu na zakłócenia oraz rozszerzyło zakres tolerowanych napięć zasilania 
programowanego układu. 
Komunikacja z komputerem odbywa się za pomocą złącza USB. Urządzenie 
bezproblemowo funkcjonuje w większości systemów operacyjnych (Windows XP, 
Windows VISTA, Windows 7).
AVR PROG MKII współpracuje m.in. z AVR Studio, CodeVisionAVR, Image Craft. 
Programator ma możliwość zmiany firmware z poziomu komputera - nie jest 
potrzebne dodatkowe urządzenie. 
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2. Opis
2.1 Diody LED

POWER - dioda sygnalizująca zasilanie bufora wyjściowego
    programatora. Zasilanie bufora jest niezbędne do prawidłowej 

  pracy urządzenia. Bufor może być zasilony z USB (nałożona 
  zworka USB POWER) lub z zewnątrz (napięcie doprowadzone 
  do pinu VCC programatora).

DATA - dioda sygnalizująca wymianę danych między komputerem a 
  programatorem. W pozycji spoczynkowej dioda powinna być 
  wygaszona a zapalać się tylko podczas transmisji USB 
  związanej z podłączeniem urządzenia, nawiązaniem 
  komunikacji z oprogramowaniem na komputerze lub 
  programowaniem mikrokontrolera. 
  Przy pierwszym podłączeniu programatora dioda ta świeci się 
  do czasu zakończenia instalacji sterownika. 
  Ciągłe świecenie się diody może oznaczać błąd

    inicjacji połączenia USB, nieprawidłową instalację sterownika 
  lub po prostu niezainstalowany programator.
  

STATUS - świecenie się diody oznacza stan gotowości programatora. 
  Zgaszona dioda może oznaczać nieprawidłową inicjację      
  urządzenia, nieprawidłową instalację sterownika lub 
  niezainstalowanie programatora.
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2.2 Zworki

POWER - Zworka zdjęta – zasilanie programatora (bufora wyjściowego)  
   z programowanego układu.
  Zworka założona - pin VCC programatora jest pinem 

      wyjściowym z którego można zasilić układ programowany. 
  W  zależności od konfiguracji zworki napięcie na pinie VCC 
  może wynosić  3.3V lub ok. 5V. 

    

UWAGA ! JEŚLI PODŁĄCZONY UKŁAD  POSIADA WŁASNE ŹRÓDŁO 
ZASILANIA, ZWORKA POWER W PROGRAMATORZE POWINNA BYĆ ZDJĘTA A NAPIĘCIE 

ZASILANIA PODŁĄCZONEGO MIKROPROCESORA 
DOPROWADZONE DO PINU VCC PROGRAMATORA *

*Zdejmując zworkę POWER odłączamy zasilanie USB od bufora wyjściowego 
programatora. Aby zasilić bufor należy doprowadzić napięcie z podłączonego 

mikrokontrolera do pinu VCC programatora.

UWAGA ! Magistrala PDI w mikrokontrolerach XMEGA nie jest 
przystosowana  do logiki 5V ! Podczas korzystania ze złącza PDI zworka POWER 
powinna być w pozycji 3.3V lub powinna być całkowicie zdjęta - w takiej sytuacji 

napięcie doprowadzone do pinu VCC nie powinno przekraczać 3,6 V. 
Niezastosowanie się do zalecenia grozi uszkodzeniem programowanego 

mikrokontrolera ATXMEGA. 
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BOOT - Założona zworka w chwili podłączenia programatora do 
  komputera lub resetu programatora powoduje uaktywnienie 
  bootloadera (DFU). W trybie DFU diody DATA i STATUS 

    są wygaszone.  Podczas normalnej pracy zworka powinna być 
  zdjęta.

RESET - krótkotrwałe zwarcie pinów RESET powoduje restart 
  programatora.
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2.3 Złącze ISP

MOSI - linia wyjściowa. Dane nadawane w kierunku programator → 
  mikrokontroler.

VCC - w zależności od konfiguracji zworki POWER jest to wejście lub 
  wyjście. Jeśli zworka POWER jest zdjęta, do pinu VCC     

    niezbędne jest doprowadzenie napięcia zasilania z programowanego 
  mikrokontrolera. Napięcie to służy do zasilenia bufora wyjściowego 

            programatora i dla magistrali ISP powinno zawierać się w przedziale  
  od 2V do 5.5V.
  Przy założonej zworce POWER pin VCC jest pinem wyjściowym i 

      może służyć do zasilenia programowanego mikrokontrolera. 
    W  zależności od konfiguracji zworki napięcie na pinie VCC 

  może wynosić  3.3V lub ok. 5V.  Przy  tym należy pamiętać o   
  ograniczonej wydajności prądowej portu USB  (ok. 500mA), 

            bezpiecznie jest jednak nie przekraczać wartości  150mA.
GND - sygnał masy.
RST - reset.
SCK - sygnał zegarowy.
MISO - linia wejściowa. Dane odbierane przez programator.
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2.4 Złącze TPI

DATA - dwukierunkowa linia danych.
CLK - sygnał zegarowy.
RST - reset.
VCC - w zależności od konfiguracji zworki POWER jest to wejście lub 

  wyjście. Jeśli zworka POWER jest zdjęta, do pinu VCC     
    niezbędne jest doprowadzenie napięcia zasilania z programowanego 

  mikrokontrolera. Napięcie to służy do zasilenia bufora wyjściowego 
            programatora i powinno zawierać się w przedziale od 1,7V do 5,5V.

  Przy założonej zworce POWER pin VCC jest pinem wyjściowym i 
      może służyć do zasilenia programowanego mikrokontrolera. 
    W  zależności od konfiguracji zworki napięcie na pinie VCC 

  może wynosić  3.3V lub ok. 5V.  Przy  tym należy pamiętać o   
  ograniczonej wydajności prądowej portu USB  (ok. 500mA), 

            bezpiecznie jest jednak nie przekraczać wartości  150mA.
GND - sygnał masy.
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2.5 Złącze PDI

DATA - dwukierunkowa linia danych.
CLK - sygnał zegarowy.
VCC - w zależności od konfiguracji zworki POWER jest to wejście lub 

  wyjście. Przy konfiguracji z zasilaniem zewnętrznym, doprowadzone  
  do pinu VCC napięcie powinno zawierać się  w granicach od 1,7V do 
  3,6V. 

UWAGA ! Magistrala PDI w mikrokontrolerach XMEGA nie jest 
przystosowana  do logiki 5V ! Podczas korzystania ze złącza PDI zworka POWER 
powinna być w pozycji 3.3V lub powinna być całkowicie zdjęta - w takiej sytuacji 

napięcie doprowadzone do pinu VCC nie powinno przekraczać 3,6 V. 
Niezastosowanie się do zalecenia grozi uszkodzeniem programowanego 

mikrokontrolera ATXMEGA. 

GND - sygnał masy.
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3. Instalacja sterowników

Programator należy podłączyć do komputera za pomocą znajdującego się w 
komplecie kabla mini USB. Jeśli jest to pierwsze uruchomienie urządzenia zostanie 
uruchomiony kreator  znajdowania nowego sprzętu. 

W kreatorze należy wybrać opcję 'Nie, nie tym razem' i nacisnąć 'Dalej'.
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W następnym oknie instalatora należy wybrać opcję 'Zainstaluj z listy lub określonej  
lokalizacji (zaawansowane)' i nacisnąć 'Dalej'.

W kolejnym oknie należy wskazać lokalizację sterowników:
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W planszy która się pojawi wybieramy opcję 'Wyszukaj najlepszy sterownik w tych 
lokalizacjach' oraz zaznaczamy 'Uwzględnij tę lokalizację w wyszukiwaniu '. 
Wciskamy 'Przeglądaj ' i wskazujemy lokalizację '...\Atmel\AVR Tools\usb' z miejsca 
instalacji AVR Studio czyli zazwyczaj 'C:\Program Files'

System powinien znaleźć i zainstalować sterowniki z podanej lokalizacji.

Jeśli proces instalacji przebiegł prawidłowo, Kreator poinformuje o prawidłowym 
zakończeniu instalacji sterowników.
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Po wyświetleniu okna końca pracy kreatora należy wcisnąć przycisk 'Zakończ'.
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Po poprawnej instalacji programatora, w oknie Menadżer urządzeń w gałęzi Jungo 
powinno pojawić się urządzenie AVRISP mkII.

W przypadku podłączenia programatora do innego portu USB niż ten w którym był 
zainstalowany, proces instalacji trzeba będzie powtórzyć.
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4. Podłączenie programatora do układu

4.1 Podłączenie przez ISP

Sygnały magistrali ISP z programatora należy połączyć z odpowiednimi liniami 
interfejsu ISP programowanego układu. Rozkład portów odpowiedzialnych  za 
programowanie w systemie (Serial Programming Pin Mapping) należy wcześniej 
sprawdzić w dokumentacji do posiadanego mikrokontrolera. W niektórych 
mikroprocesorach magistrala ISP pokrywa się ze sprzętową magistralą SPI (np. 
ATmega8), w innych magistrala do programowania ulokowana jest pod innymi 
portami (np. ATmega 128). Podłączając mikrokontroler do programatora należy 
więc zwrócić uwagę że nie zawsze ISP jest tożsame z SPI. 

Łączymy odpowiednio:
Złącze ISP programatora Magistrala ISP mikrokontrolera

MOSI MOSI
MISO MISO
SCK SCK
RST RESET
VCC* VCC
GND GND
* Linie VCC i GND powinny być połączone z VCC i GND programowanego 
mikrokontrolera. Wartość napięcia doprowadzonego do VCC powinna zawierać się 
w przedziale od 2V do 5,5V. Zworka POWER musi być zdjęta jeśli mikrokontroler 
zasilany jest ze swojego źródła. W przypadku zasilania programowanego układu z 
programatora, zworka ma być założona (w zależności od potrzeby w pozycji 3,3V 
lub 5V). 

Copyright © 2010 SIBIT www.sibit.pl AVR PROG MKII    15

http://www.sibit.pl/


4.2 Podłączenie przez PDI

Sygnały magistrali PDI z programatora należy połączyć z odpowiednimi liniami 
interfejsu PDI programowanego układu. 

Łączymy odpowiednio:
Złącze PDI programatora Magistrala PDI mikrokontrolera

DATA DATA
CLK CLK
VCC* VCC
GND GND

* Linie VCC i GND powinny być połączone z VCC i GND programowanego 
mikrokontrolera. Przy konfiguracji z zasilaniem zewnętrznym wartość napięcia 
doprowadzonego do VCC powinna zawierać się w przedziale od 1,7V do 3,6V. 

UWAGA ! Magistrala PDI w mikrokontrolerach XMEGA nie jest 
przystosowana  do logiki 5V ! Podczas korzystania ze złącza PDI zworka POWER 
powinna być w pozycji 3.3V lub powinna być całkowicie zdjęta - w takiej sytuacji 

napięcie doprowadzone do pinu VCC nie powinno przekraczać 3,6 V. 
Niezastosowanie się do zalecenia grozi uszkodzeniem programowanego 

mikrokontrolera ATXMEGA. 
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4.3 Podłączenie przez TPI

Sygnały magistrali TPI z programatora należy połączyć z odpowiednimi liniami 
interfejsu TPI programowanego układu. 

Łączymy odpowiednio:
Złącze TPI programatora Magistrala TPI mikrokontrolera

DATA DATA
CLK CLK
RST RST
VCC* VCC
GND GND

* Linie VCC i GND powinny być połączone z VCC i GND programowanego 
mikrokontrolera. Wartość napięcia doprowadzonego do VCC powinna zawierać się 
w przedziale od 1,7V do 5,5V. Zworka POWER musi być zdjęta jeśli mikrokontroler 
zasilany jest ze swojego źródła. W przypadku zasilania programowanego układu z 
programatora, zworka ma być założona (w zależności od potrzeby na pozycję 3,3V 
lub 5V).
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5. Współpraca z oprogramowaniem

5.1 AVR Studio

W celu połączenia z programatorem wybieramy AVR Studio -> Tools -> Program 
AVR -> Connect.

W oknie Select AVR Programmer jako Platform wybieramy AVRISP mkII ,port USB i 
naciskamy Connect
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Po kliknięciu Connect powinno pojawić się okno obsługi programatora.

Uwaga ! AVR Studio nie posiada autodetekcji typu podłączonego  do programatora 
mikrokontrolera, dlatego bardzo ważne jest, żeby przed przystąpieniem do 
jakichkolwiek operacji związanych z programowaniem, w polu Device and 
Signature Bytes zakładki Main ręcznie wybrać z rozwijanej listy typ docelowego 
mikroprocesora. 
Wciskając przycisk Read Signature należy sprawdzić czy prawidłowo jest 
rozpoznawana sygnatura (Signature matches selected device). Jeśli odczytana 
sygnatura nie pasuje do typu wybranego mikrokontrolera (WARNING:Signature 
does not match selected device!), należy zweryfikować poprawność połączeń 
mędzy programatorem a mikrokontrolerem, zwrócić uwagę na właściwe zasilanie 
układu, upewnić się czy w polu Device and Signature Bytes prawidłowo został 
wybrany typ mikrokontrolera.
Warto również ustawić optymalną prędkość programowania (zakładka Main, 
przycisk Settings) pamiętając przy tym o zależności iż częstotliwość magistrali 
programatora powinna być równa lub mniejsza od ¼ częstotliwości taktowania 
programowanego mikrokontrolera. 
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5.2 CodeVisionAVR
Typ  programatora  ustawiamy  w  CodeVisionAVR->Settings->Programmer.  Z 
rozwijanej listy wybieramy  Atmel AVRISP MkII(USB).

Aplikację do obsługi programatora wywołujemy z Menu->Tools->Chip Programmer
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6. Zmiana firmware programatora

6.1 Instalacja programatora w trybie DFU
Do zmiany firmware w programatorze niezbędna jest uprzednia instalacja programu 
FLIP dostępnego na stronie Atmela.
Aby programator wprowadzić w tryb DFU (Device Firmware Update) w urządzeniu 
należy założyć środkową zworkę (BOOT) i podłączyć do komputera. 
Po podłączeniu, diody STATUS oraz DATA powinny być wygaszone. Przy pierwszej 
aktualizacji komputer wykryje nowe urządzenie i uruchomi kreator instalacji.

W kreatorze należy wybrać opcję 'Nie, nie tym razem' i nacisnąć 'Dalej'.
W następnym oknie instalatora należy wybrać opcję 'Zainstaluj z listy lub określonej  
lokalizacji (zaawansowane)' i nacisnąć 'Dalej'.
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W następnym kroku należy wskazać lokalizację sterowników. W tym celu 
wybieramy opcję 'Wyszukaj najlepszy sterownik w tych lokalizacjach' oraz 
zaznaczamy 'Uwzględnij tę lokalizację w wyszukiwaniu '. Wciskamy 'Przeglądaj ' i 
wskazujemy lokalizację instalacji programu FLIP  - '...\Atmel\Flip x.x.x\usb'.
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System powinien znaleźć i zainstalować sterowniki z podanej lokalizacji.

Jeśli proces instalacji przebiegł prawidłowo, Kreator poinformuje o prawidłowym 
zakończeniu instalacji sterowników.

Po wyświetleniu okna końca pracy kreatora należy wcisnąć przycisk 'Zakończ'.
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Po poprawnej instalacji programatora w trybie DFU, w oknie Menadżer urządzeń 
powinna pojawić się gałąź Atmel USB Devices z gałęzią AT90USB162. 
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6.2 Obsługa programu Atmel FLIP

Po urzednim wprowadzeniu programatora w tryb DFU (programator podłączony do 
komputera z założoną środkową zworką) należy uruchomić program FLIP .
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W programie należy wybrać urządzenie do zaprogramowania -  'Device -> Select'. 
Należy zaznaczyć AT90USB162 i klknąć 'OK'

Następnie nacisnąć na ikonkę symbolizującą kabel USB, wybrać USB i w okienku 
USB Port Connection które się pojawi wcisnąć OPEN:
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Po pomyślnym otwarciu portu powinno pojawić się okno:

Następnie należy wskazać docelowy plik *.hex z firmware - 'File->Load HEX File...' i 
nacisnąć przycisk 'Run' (lewy dolny róg). Po skończonej aktualizacji należy 
zamknąć program (File ->Exit), odłączyć programator i zdjąć zworkę BOOT.
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7. Lista obsługiwanych układów
Mikrokontroler ISP PDI TPI

AT90CAN128 x
AT90CAN32 x
AT90CAN64 x
AT90PWM2 x
AT90PWM216 x
AT90PWM2B x
AT90PWM3 x
AT90PWM316 x
AT90PWM3B x
AT90USB1286 x
AT90USB1287 x
AT90USB162 x
AT90USB646 x
AT90USB647 x
AT90USB82 x
ATtiny10 x
ATtiny12 x
ATtiny13 x
ATtiny13A x
ATtiny15 x
ATtiny167 x
ATtiny20 x
ATtiny2313 x
ATtiny2313A x
ATtiny24 x
ATtiny24A x
ATtiny25 x
ATtiny26 x
ATtiny261 x
ATtiny261A x
ATtiny4 x
ATtiny40 x
ATtiny4313 x
ATtiny43U x
ATtiny44 x
ATtiny44A x
ATtiny45 x
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Mikrokontroler ISP PDI TPI
ATtiny461 x
ATtiny461A x
ATtiny48 x
ATtiny5 x
ATtiny84 x
ATtiny85 x
ATtiny861 x
ATtiny861A x
ATtiny88 x
ATtiny9 x
ATmega128 x
ATmega1280 x
ATmega1281 x
ATmega1284 x
ATmega1284P x
ATmega128A x
ATmega16 x
ATmega162 x
ATmega164A x
ATmega164P x
ATmega164PA x
ATmega165 x
ATmega165A x
ATmega165P x
ATmega168 x
ATmega168A x
ATmega168P x
ATmega168PA x
ATmega169 x
ATmega169A x
ATmega169P x
ATmega169PA x
ATmega16A x
ATmega16HVB x
ATmega16U2 x
ATmega16U4 x
ATmega2560 x
ATmega2560 x
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Mikrokontroler ISP PDI TPI
ATmega2561 x
ATmega32 x
ATmega324A x
ATmega324P x
ATmega324PA x
ATmega325 x
ATmega3250 x
ATmega3250A x
ATmega3250P x
ATmega325A x
ATmega325P x
ATmega328 x
ATmega328P x
ATmega329 x
ATmega3290 x
ATmega3290A x
ATmega3290P x
ATmega329A x
ATmega329P x
ATmega329PA x
ATmega32A x
ATmega32C1 x
ATmega32HVB x
ATmega32M1 x
ATmega32U2 x
ATmega32U4 x
ATmega32U6 x
ATmega48 x
ATmega48A x
ATmega48P x
ATmega48PA x
ATmega64 x
ATmega640 x
ATmega644 x
ATmega644A x
ATmega644P x
ATmega644PA x
ATmega645 x
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Mikrokontroler ISP PDI TPI
ATmega6450 x
ATmega6450A x
ATmega6450P x
ATmega645A x
ATmega645P x
ATmega649 x
ATmega6490 x
ATmega6490A x
ATmega6490P x
ATmega649A x
ATmega649P x
ATmega64A x
ATmega64HVE x
ATmega8 x
ATmega8515 x
ATmega8535 x
ATmega88 x
ATmega88A x
ATmega88P x
ATmega88PA x
ATmega8A x
ATmega8HVD x
ATmega8U2 x
ATxmega128A1 x
ATxmega128A1_revD x
ATxmega128A1U x
ATxmega128A3 x
ATxmega128D3 x
ATxmega16A4 x
ATxmega16D4 x
ATxmega192D3 x
ATxmega256A3 x
ATxmega256A3B x
ATxmega256D3 x
ATxmega32D4 x
ATxmega64A1 x
ATxmega64A3 x
ATxmega64D3 x
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8. Nota prawna

Firmware programatora bazuje na projekcie LUFA którego autorem jest Dean 
Camera. Aktualna wersja wsadu urządzenia jest kompilacją wersji LUFA100807. 
Projekt LUFA (Lightweight USB Framework for AVRs) w chwili obecnej jest 
rozpowszechniany na warunkach zmodyfikowanej licencji MIT.
Zgodnie z warunkami tej licencji i życzeniem twórcy oprogramowania 
zamieszczamy poniższe informacje odnośnie wsadu programatora:

  Copyright 2010  Dean Camera (dean [at] fourwalledcubicle [dot] com)

  Permission to use, copy, modify, distribute, and sell this 
  software and its documentation for any purpose is hereby granted

  without fee, provided that the above copyright notice appear in 
  all copies and that both that the copyright notice and this

  permission notice and warranty disclaimer appear in supporting 
  documentation, and that the name of the author not be used in 

  advertising or publicity pertaining to distribution of the 
  software without specific, written prior permission.

  The author disclaim all warranties with regard to this
  software, including all implied warranties of merchantability
  and fitness.  In no event shall the author be liable for any

  special, indirect or consequential damages or any damages
  whatsoever resulting from loss of use, data or profits, whether

  in an action of contract, negligence or other tortious action,
  arising out of or in connection with the use or performance of

  this software.
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9. Kontakt - wsparcie techniczne

W celu uzyskania dodatkowej pomocy technicznej skontaktuj się z nami 
serwis@sibit.pl

Windows is a registered trademark of Microsoft Corporation.
ATMEL, AVR, XMEGA, FLIP and AVR Studio are the registered trademarks of Atmel.

CodeVisionAVR is trademark of HP InfoTech.
All other brand names or product names are the property of their respective holders.
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